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Ejercicio 1: Crear un Simple VI de LabVIEW 

El ejercicio cuenta con 16 pasos que completará en aproximadamente 4 a 10 min dependiendo de 
la experiencia con la computadora. 

Si usted sólo quiere ver la funcionalidad del programa sin realizar el ejercicio puede abrirlo 
directamente del fólder de C:\NI Days Hands-On\IntroLabVIEW\Solutions con el 
nombre Exercise1.vi 

 

¿Que hace el ejercicio? 

Simulando una señal de entrada a la computadora, usted programa una alarma dependiendo si 
esta señal está por encima de un límite controlado por el usuario. 

 

Comience aquí 

1. Seleccione la carpeta More y se abrirá el Application Template Browser (Explorador de 
prediseño de Aplicaciones).  

Note las diferentes categorías y tareas en la parte izquierda de la ventana que puede elegir.  

 
 
2. Seleccione VI» from Template»Tutorial (Getting Started) y seleccione Generate and 

Display, presione OK. Dos ventanas aparecerán. La ventana gris se llama Panel Frontal y la 
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blanca el Diagrama de Bloques. El Panel Frontal incluye la interfaz del usuario mientras que 
el diagrama de bloques contiene el código que rige el comportamiento del VI.  
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3. Examine el Panel Frontal y el Diagrama de Bloques de este VI prediseñado. El Panel Frontal 
contiene una gráfica de forma de onda (Waveform Chart) y un botón de Stop (alto) como se 
muestra aquí. 

 

El Diagrama de Bloques contiene un VI que simula una señal (Simulate Signal), el cual está 
configurado para simular una señal senoidal y dibujarla en la gráfica de forma de onda. 

 

4. Regrese al Panel Frontal presionando <Ctrl-E>. Dado que el botón de Run (correr) ubicado 
en la esquina superior izquierda es de color blanco, significa que el VI no contiene errores y 
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puede ser corrido. Presiónelo para examinar la operación del VI. Cuando haya terminado 
presione el botón de STOP del Panel Frontal.  

    
 
5. Ahora vamos a añadir más funciones al VI. Lo programaremos para que haga prender una 

alarma cuando la señal esté por encima de cierto valor. Abra la paleta Controls (paleta de 
controles) presionando el botón derecho sobre cualquier parte del Panel Frontal. Para dejar la 
ventana fija, presione la pequeña tachuela que está en la parte superior izquierda como se 
muestra aquí. 

 

6. En la paleta de controles de clic en Numeric Controls (Controles Numéricos), y seleccione 
Vertical Pointer Slide (barra de desplazamiento vertical). Colóquelo en el Panel Frontal 
simplemente dando un solo clic en donde se desee colocarla. 
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7. Presione la opción Modern en la parte superior izquierda de la subpaleta de Controles 
Numéricos para regresar a la paleta Principal. Presione Boolean y coloque un Round LED 
(foco redondo). 
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8. Presione el botón derecho del Mouse sobre la barra de desplazamiento vertical y seleccione 
Properties (Propiedades). Una ventana de propiedades aparecerá. Examine las diferentes 
opciones que puede modificar. Haga los siguientes cambios en la pestaña de Appearance 
(Apariencia) y seleccione OK cuando termine. 

Label: Limit 

Slider 1: Palomee Show Digital Display(s) 

 

9. En el panel frontal haga doble clic sobre la palabra boolean (etiqueta del LED) y entre el 
texto Alarm. Al final el Panel frontal se verá similar a éste. 
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10. Cambie al Diagrama de Bloques presionando <Ctrl-E>. Haga doble clic en el VI Express 
Simulate Signal (Simular Señal) para desplegar las propiedades. Examine las diferentes 
propiedades que puede modificar. Cambie la Amplitud de la señal (Amplitude) a 10. 
Presione OK para guardar los cambios y cerrar la ventana. 
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11. Abra la paleta de Funciones presionando el botón derecho del mouse sobre el Diagrama de 

Bloques. Seleccione Programming » Comparison (esto abre la paleta de comparación). 
Agregue la función Comparison (Comparación) al diagrama. 

 

 

 

Cuando coloque el bloque de comparación en el Diagrama de Bloques una ventana como la 
siguiente aparecerá, la cual le permite configurar el tipo de comparación que quiere hacer. Haga 
las siguientes modificaciones y luego presione OK para aplicar los cambios y cerrar la ventana. 
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Compare Condition: Greater  

Comparison Inputs: Compare to second input 

 

12. Haga que su Diagrama de Bloques se asemeje a la siguiente imagen completando los 
siguientes pasos. 

a. Conecte el control Limit a la entrada Operand 2 (Operando 2) de la función 
Comparison. 

b. Conecte un cable entre el bloque Simulate Signals y la gráfica de forma de onda 
Waveform Graph a la entrada Operand 1 del bloque Comparison. 

c. Conecte la salida Result (Resultado) del bloque Comparison hacia el indicador Alarm. 
 
Su Diagrama de Bloques se debe parecer al siguiente. 
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13. Pase al Panel Frontal presionando <Ctrl-E>. 

14. Corra el VI presionando la flecha blanca en la esquina superior izquierda (como en el paso 
4). Mientras corre, note que puede cambiar el valor de Limit. Note también que cuando el 
dato recibido de Simulated Signal VI es mayor que el valor de Limit, entonces la luz Alarm 
se prende. 

15. Mientras se ejecuta, cambie al Diagrama de Bloques presionando <Ctrl-E>. Presione el icono 
que parece una bombilla en la barra de herramientas. 

 

Esto le permitirá ver el flujo de los datos a través del programa. 
16. Cuando acabe, pare el VI presionando el botón de Stop en el Panel Frontal. 

 

Fin del Ejercicio 1 
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Ejercicio 2: Presentación con Paneles Remotos 

 

El ejercicio cuenta con 16 pasos que completará en aproximadamente 3 a 6 min dependiendo de 
la experiencia con la computadora. 

Si usted sólo quiere ver la funcionalidad del programa sin realizar el ejercicio puede abrirlo 
directamente del fólder de C:\NI Days Hands-On\IntroLabVIEW\Solutions con el 
nombre Exercise2.vi 

 

¿Que hace el ejercicio? 

Con un VI ya realizado usted podrá monitorear y controlarlo de manera remota (vía Web) 
gracias a los paneles frontales de LabVIEW. 

 

1. Seleccione la opción Find Examples que se encuentra en la esquina inferior derecha. 

 

2. Navegue por las siguientes carpetas Analyzing and Processing Signals » Signal and Noise 
Generation hasta encontrar el ejemplo Signal Generation and Processing. 
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3. Aparecerá el siguiente Panel Frontal. 

 

4. Corra el VI y modifique los controles para ver la funcionalidad de los mismos. Pare el VI 
cuando haya terminado. 

5. Guarde el VI en el fólder C:\NI Days Hands-On\IntroLabVIEW\Exercises 
seleccionando File»Save As. Posteriormente seleccione la opción Copy y Substitute for 
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original y oprima el botón Continue. Guarde el VI con el nombre de Exercise2.vi y 
presione OK. 

6. Ahora que tenemos un VI que simula y analiza los datos es tiempo de presentar los datos 
usando los Paneles Remotos de LabVIEW. 

7. De la barra de menú seleccione Tools»Web Publishing Tool. Esto abrirá una herramienta 
que permite crear un Panel Remoto con sólo unos clics. 

8. En el apartado VI name seleccione su VI (Exercise2.vi) y arranque el servidor Web haciendo 
clic en el botón Start Web Server. Posteriormente oprima el botón  Next >. 

9. VI name: Exercise2.vi 

 

 

10. Nota: Si el servidor ya ha sido inicializado, el botón Start Web Server aparecerá 
deshabilitado. 

11. Cambie el título en Document Title, el encabezado en Header y el pie de página en Footer a 
que digan lo siguiente:  

Document Title: Remote Panels: Exercise 2 

Header: Signal Generation and Processing 

Footer: This VI simulates a sine wave signal and performs filtering and windowing on 
that signal. It also displays the power spectrum of the signal. 
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12. Presione el botón Next >. 

13. Guarde la configuración a disco como un documento HTML haciendo clic en el botón Save 
to Disk. Guárdelo con el nombre (File name ) Exercise2  

14. Rectifique que el lugar donde lo está guardando es el correcto C:\Program 
Files\National Instruments\LabVIEW 8.2\www  
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15. Le mostrará entonces una ventana con la dirección URL para conectarse a este Panel Remoto 
similar al de la siguiente figura pero con el nombre de su computadora. Presione Connect 
(Conectar) 

 

16. El navegador de páginas Web aparecerá. Maximice la ventana para que ocupe la totalidad de 
la pantalla. 

17. Para controlar el VI desde el navegador Web presione el botón izquierdo del mouse sobre el 
Panel Frontal del Panel Remoto y seleccione Request Control of VI. 

18. El mensaje “Waiting for control: Either the server is locked or 
another client has control” puede aparecer. Si este es el caso, simplemente 
espere un momento en lo que se establece el control remoto. 



  

© National Instruments Corporation 19 NI Days 2006 Hands-On 

19. El mensaje “Control granted” aparecerá indicando que el control le ha sido 
concedido. 

20. Corra el VI. Modifique los controles para demostrar que en verdad usted es capaz de 
controlar el VI remotamente. Usted puede detener e iniciar el VI para demostrar que los 
Paneles Remotos de LabVIEW le dan control absoluto del VI. 

21. Cuando esté controlando el VI, usted puede nuevamente presionar el botón derecho del 
Mouse sobre el Panel Remoto y seleccionar Remote panel client» Release Control of VI  
dejando así nuevamente el control del VI. 

22. También puede conectarse y controlar el VI desde otra computadora en la red. Simplemente 
ingrese la URL correcta y podrá remotamente ver y controlar el VI en el equipo. 

23. Pare y cierre el VI así como el navegador Web. 

Fin del Ejercicio 2 
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Ejercicio 3: LabVIEW Mathscript Node 

 
¿Que hace el ejercicio? 

 
Este ejercicio explora cómo se puede “instrumentar un archivo .m” analizando información, tan 
sólo utilizando el script de dicho archivo.  Aunque este ejercicio es sencillo, las ideas y técnicas 
que le serán expuestas pueden ser fácilmente adaptadas para implementación de otras 
aplicaciones. 
 
Descripción: 

 
Al ejecutar sus scripts de archivos .m con LabVIEW MathScript, usted podrá tener acceso a 
todas las sobresalientes características de LabVIEW tal como lo son: procesos de adquisición de 
datos simplificados, control de instrumentos sencillo, escritura y lectura de archivos, 
conectividad a bases de datos y desarrollo de interfaces de usuario. 

 
Nota: Este ejercicio requiere LabVIEW 8.20 Full, Professional o Student Edition. 

 
Archivos necesarios para realizar este ejercicio: 

• C:\NI Days Hands On\MathScript\Exercises\applyFFT.m 

• C:\NI Days Hands On\MathScript\Exercises\Mitra P2_1.m 
 
Pasos: 

1. Abra LabVIEW y abra un VI en blanco.  
 

Usted comenzará definiendo la interfaz de usuario para una aplicación a través del Panel 
Frontal. Su interfaz de usuario incluirá dos gráficas – una para desplegar la señal simulada y 
otra para desplegar la señal procesada-. 
 

2. Agregue una gráfica de forma de onda (Waveform graph) al Panel Frontal. Haga doble clic  
en la etiqueta de la gráfica y cámbiela a Signal Samples. 

 
3. Agregue  una segunda gráfica de forma de onda al Panel Frontal. Haga doble clic en la 

etiqueta de la gráfica y cámbiela a FFT Result. 
 

4. Despliegue el Diagrama de Bloques de este VI <Ctrl-E>. Su Diagrama de Bloques bebe de 
ser similar al siguiente. 
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5. Despliegue la paleta de funciones seleccionando View»Functions Palette.  
 
6. En la paleta de funciones seleccione Programming>>Structures  y de clic en MathScript 

Node. Mueva su mouse al diagrama de bloques y posteriormente dé clic izquierdo, arrastre el 
Mouse y haga clic izquierdo de nuevo para insertar el nodo de MathScript en el diagrama de 
bloques. 

 
Existen dos formas para ingresar comandos de un archivo .m en el nodo de MathScript. 
Usted puede ingresar al nodo comandos de forma directa o usted puede importar archivos .m 
que usted tenga en su computadora.  
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7. Importe el sript de un archivo .m al nodo de MathScript oprimiendo clic derecho sobre el 

borde del nodo y seleccionando Import en el menú rápido. Usted importará el archivo 
llamado applyFFT.m de la carpeta C:\NI Days Hands 
On\MathScript\Exercises\, el cual contiene los siguientes comandos: 
 
fftresult=abs(fft(signalin)); 
fftresult=fftresult(1:end/2); 
 
 

 
 
Explicación: El comando fftresult=abs(fft(signalin); realiza lo siguiente: 

a. Manda llamar la funcion fft para aplicar una transformada rápida de Fourier al 
vector de entrada llamado signalin. 

b. Manda llamar la función abs para calcular el valor absoluto de la función fft. 
c. Asigna el valor a la variable fftresult. 

 
El comando fftresult=fftresult(1:end/2); asigna a la variable fftresult la primera mitad de 
los datos obtenidos en la línea anterior. La razón para realizar esto es debido a que el 
resultado de aplicar la FFT a una señal real genera una señal simétrica, debido a esto, es muy 
común analizar tan solo la primera parte de dicha señal.  

 
8. Posteriormente, usted tendrá que generar la interfaz entre el mundo basado en texto de un 

archivo .m a la programación gráfica manejada por LabVIEW, todo esto se logra tan solo 
presionando clic derecho sobre el marco del nodo de  MathScript para determinar las 
entradas y salidas. Haga clic derecho en el borde izquierdo del nodo de MathScript (línea 
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azul) y seleccione Add Input en el menú corto. Escriba signalin en la terminal de entrada 
para agregar la entrada de la variable  signalin en el script. 

 

 
 
Explicación: Ingresando el texto signalin se asocia esta terminal con la variable signalin en 
el script del archivo .m, habilitando el ingreso de nuevos valores a dicha variable.  
 

9. Haga clic derecho en el borde derecho del nodo de MathScript (linea azul) y seleccione Add 
Output en el menú rápido. Escriba fftresult en la terminal de salida con el objetivo de 
relacionar una salida a la variable fftresult del script. 

 
Explicación: Como consecuencia de este paso se obtiene que el resultado del script del 
archivo .m esté disponible como una salida cuyos datos pueden ser utilizados por el resto de 
su aplicación en LabVIEW. 

 
10. Haga clic derecho sobre la terminal de salida fftresult y seleccione Choose Data Type»1D-

Array»DBL 1D desde el menú corto para especificar a qué tipo de dato es al que pertenece 
la variable de salida  fftresult. 

 
 
Explicación: Este paso define el tipo de dato al que pertenece la salida del nodo de 
MathScript. 

 
11. Agregue un While loop (ciclo While), que se encuentra en la paleta de funciones en 

Programming>>Structures, de tal manera que encapsule a todos los elementos que ha 
agregado al Diagrama de Bloques. 

 
Explicación: El ciclo While permite que tanto la adquisición y el análisis en su código corran 
continuamente.  



  

© National Instruments Corporation 24 NI Days 2006 Hands-On 

 

 
 
12. Haga clic derecho en la terminal de condición de paro del ciclo y seleccione Create»Control 

para agregar un botón de Stop en el Panel Frontal. 
 
13. Agregue el VI Express Simulate Signal que se encuentra en  Express>>Input en la paleta 

de funciones. Agregue este VI dentro del ciclo While a la  izquierda del nodo de MathScript.  
 

Explicación: El VI Simulate Signal va a simular una adquisición de datos de un dispositivo 
de medición.  

 
14. Seleccione  los siguientes atributos en la ventana de configuración del VI y presione OK. 

• Signal 
o Signal type = Square  
o Frequency = 50 Hz 
o Add noise = márquelo con una paloma 
o Noise type = Uniform White Noise 
o Noise amplitude = 0.3 

• Timing 

o Samples per second (Hz) = 10000 
o Automatic = checked 
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15. Conecte la terminal de salida del VI Express Simulate Signal a la gráfica Signal Samples 
para desplegar la señal.  

 
16. Agregue el VI Express Convert from Dynamic Data que se encuentra en la paleta de 

funciones en Express » Signal Manipulation.  Dé clic en OK para seleccionar la 
configuración por defecto para ese VI y cerrar el dialogo de configuración. 
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Explicación: Este VI Express convierte los datos de una representación de dato dinámico a 
un arreglo de una dimensión de escalares. 

 

17. Cablee  la salida del VI Express Simulate Signal  a la entrada del VI Express Convert from 
Dynamic Data. 

18. Cablee la salida del VI Convert from Dynamic Data  a la entrada signalin del nodo de 
MathScript. 

19. Cablee la salida fftresult del nodo de MathScript a la gráfica FFT Result.  
 

 
 

20. Vuelva  al panel frontal y presione el botón de Run  para comenzar la ejecución de su 
aplicación. Cuando ejecute el VI, usted puede ver la señal generada en la gráfica de la 
izquierda y la señal analizada en la gráfica ubicada del lado derecho.  

 
 

 
 
21. Pare el VI presionando el botón Stop. 
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22. Regrese al Diagrama de Bloques.    
23. Agregue el VI Express Filter que se ubica en la paleta de funciones en Express>>Signal 

Analysis. El VI Express Filter  colóquelo dentro del ciclo While. 
24. Configure con los siguientes parámetros el VI Express Filter en la ventana de configuración 

y presione OK. 
• Filter type = smoothing 
• Moving average = Triangular 
• Half-width moving average = 7 

 
 

 
 
Explicación: LabVIEW provee la flexibilidad de implementar procesamiento y análisis de 
señales, ya sea de forma gráfica o con instrucciones en formato de texto. 
 

25. Cablee la salida del VI Simulate Signal a la terminal Signal del VI Express Filter. 
26. Haga clic derecho en la terminal Filtered Signal del VI Express Filter y seleccione 

Create>>Graph Indicator desde el menú rápido con el objetivo de crear una gráfica que 
despliegue la señal filtrada.  
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27. Presione Run  para ejecutar la aplicación.  
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Ejercicio 4:   Introducción a la Programación Orientada a 
Objetos en LabVIEW 

 
Propósito:  

Este ejercicio le presenta la programación orientada a objetos en LabVIEW estudiando el 
caso de las pruebas en teléfonos celular con y sin cámara.  

 

Archivos Necesarios para este Ejercicio: 

• C:\NI Days Hands On\OOP\Exercises\Phone.lvproj  

• C:\NI Days Hands On\OOP\Exercises\PhoneTester.vi 

• C:\NI Days Hands On\OOP\Exercises\Camera Phone\Camera 
Phone.lvclass 

• C:\NI Days Hands On\OOP\Exercises\Camera Phone\Test.vi 

• C:\NI Days Hands On\OOP\Exercises\Cell Phone\Cell 
Phone.lvclass 

 

Pasos: 

1. Abra Phone.lvproj desde el directorio C:\NI Days Hands On\OOP\Exercises\. 

 

 
Figura 1: Project Explorer mostrando algunas clases 

 
2. El proyecto contiene algunas clases, una representa un teléfono celular, otra representa un 

celular con cámara y otra representa una cámara. 

3. Camera Phone está compuest por Camera. Veamos la definición de la clase Camera Phone. 
Expanda Camera Phone.lvclass en el árbol del proyecto y haga doble-clic en Camera 
Phone.ctl para abrirlo. 
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Figura 2: Control de datos para Camera Phone.lvclass 

 
4. El .ctl bajo una clase define los datos para la clase. Podemos ver que Camera Phone está 

compuesto por el objeto Camera. Cierre la ventana para Camera Phone.ctl. 

5. Camera Phones son un tipo de teléfono celular. Camera Phone.lvclass hereda de la clase Cell 
Phone.lvclass para reutilizar sus métodos e implementaciones. Haga clic-derecho en Camera 
Phone.lvclass y seleccione Show Class Hierarchy para ver la relación entre las diferentes 
jerarquías. 
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Figura 3 – Jerarquía de Clases Mostrando Herencia 

 
6. Cierre la ventana de jerarquía 

7. La aplicación de alto nivel prueba teléfonos celulares. Haga doble-clic en PhoneTester.vi en 
el Project Explorer y vea el Panel Frontal y el Diagrama de Bloques de PhoneTester.vi 
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Figura 4 – Implementación de PhoneTester.vi  

 
8. El VI tiene dos objetos Cell Phone que están conectados a un arreglo y son probados uno por 

uno en un ciclo For. Corra PhoneTester.vi desde el Diagrama de Bloques. El método para 
probar el teléfono celular se deben de invocar dos veces. Presione “OK” cuando aparezca la 
ventana. 

 

 
Figura 5 – Ventana de Diálogo indicando que la prueba del  

teléfono celular está corriendo 
 
9. Ahora aumentará esta aplicación para probar teléfonos con cámara. Normalmente, necesitaría 

de una estructura Case u otros mecanismos para modificar la lógica de su código. Debido a 
que Camera Phone.lvclass hereda de Cell Phone.lvclass, podemos aprovechar la descarga 
dinámica. Haga clic-y-arrastre dos veces Camera Phone.lvclass desde el Project Explorer al 
panel frontal de PhoneTester.vi y cámbiese al diagrama de bloques. 
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Figura 6 – Camera Phone Objects on PhoneTester.vi 

 
10. Debido a que Camera Phones y Cell Phones son parte de la misma jerarquía, podemos 

juntarlos en el mismo arreglo. Expanda el nodo de Build Array ( ) de tal forma que tenga 
cuatro elementos y conecte los objetos de Camera Phone al nodo de Build Array. 

 

 
Figura 7 – Objetos Cell Phone y Camera Phone conectados al  

mismo nodo Build Array  
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11. Test.vi en el ciclo For es la implementación del método Test para la clase Cell Phone.lvclass. 
Haga doble-clic en el VI en el ciclo For. Verifique que pueda abrir Cell 
Phone.lvclass:Test.vi. 

 
12. Debido a que Camera Phone.lvclass hereda de Cell Phone.lvclass cuando el método Test se 

llama para un objeto de Camera Phone, la implementación de Test.vi para Camera 
Phone.lvclass se llama automáticamente a través de la descarga dinámica. Examine el 
diagrama de bloques de Test.vi para Camera Phone.lvclass 

 

 
Figura 8 – Implementación del método Test para Camera Phone.lvclass 

 
13. La implementación del método Test para Camera Phone.lvclass primero llama la 

implementación de la clase padre, Cell Phone.lvclass y luego llama a PhoneTester.vi en el 
objeto Camera. Cierre Camera Phone.lvclass:Test.vi.  

14. Corra la aplicación de alto nivel PhoneTester.vi desde el diagrama de bloques. 

1. Verifique que las dos primeras ventanas de diálogo que aparezcan indiquen que se está 
llamando a las pruebas para Cell Phone – que corresponde a los dos primeros elementos 
del arreglo. 

2. Verifique que la siguiente ventana de diálogo indique que se está probando Camera 
Phone, que corresponde al tercer objeto del arreglo y llama a Cell Phone Test y Camera 
Test como se muestra en la Figura 8. 

3. Verifique que el cuarto objeto en el arreglo sea probado correctamente como un Camera 
Phone. 
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Gracias a la herencia y descarga dinámica, podemos crecer nuestra aplicación aún más para 
soportar otros tipos de teléfonos, como PDAs, y así minimizar los cambios que haya que realizar 
sobre la aplicación de alto nivel. 
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Ejercicio 5: Introducción al Ambiente 

1. Vaya al menú de Start y seleccione Programs»National Instruments Vision Builder AI 
3.0. Aparecerá la ventana de bienvenida (Welcome). 

2. Presione el botón de Configure Inspection. 

3. Seleccione File»Open y después Oil Filter Inspection. 

4. A continuación se enlistan los diferentes componentes de la interfaz de configuración: 
 

 
 

1.  Ventana Principal 3.  Paleta de Pasos de Inspección 

2.  Ventana General 4.  Ventana de Configuración de 
Estados 

 

5. Sobre la Ventana Principal, hay una barra de herramientas para la prueba y edición de sus 

pasos de inspección. Presione el botón de Run Inspection Once ( ) varias vecs para 
ciclar por algunas imágenes de prueba. Observe los pasos en los cuales las imágenes fallen. 

6. Esta inspección está verificando la presencia de 8 agujeros externos en el filtro de aceite y 
verificando la presencia del anillo interno.  Ahora descargaremos la configuración cambiando 
a la Inspection Interface.. 

7. Seleccione File»Switch to Inspection Interface para cargar la Inspection interface. No 
grabe ningún cambio. 
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8. Presione el botón de Start Inspection ( ).  

9. Detenga la inspección. 

10. Cierre Vision Builder for Automated Inspection. 



  

© National Instruments Corporation 38 NI Days 2006 Hands-On 

Ejercicio 6: Encuentre el Agujero Central 

Configuración de la Adquisición 
1. Abra Vision Builder for Automated Inspection si aún no lo está y presione el botón 

Configure Inspection. 

2. Abra una nueva inspección seleccionando File»New. 

3. En la paleta de Inspection Steps, seleccione la lengüeta Acquire Images. 

 

4. Presione en el paso de Simulate Acquisition. La página de propiedades aparecerá. 

5. En la caja de texto Step Name, escriba Acquire Image. 

6. En la caja de texto Path, presione el botón de Browse. La ventana de diálogo Select an 
Image File aparecerá. 

7. Navegue a C:\NI Days Hands On\VBAI\Exercises\Oil Filter\ 

8. Seleccione la primera imagen, OilFilt0.jpg, y presione Open. 

9. Asegúrese de marcar Cycle Through Folder Images bajo la caja de texto Path. Cuando esta 
opción se habilita, Vision Builder for Automated Inspection carga una imagen diferente cada 
vez que se ejecuta el paso, lo que simula una adquisición en vivo de partes individuales. 

10. Presione OK. Vision Builder for Automated Inspection agrega el paso Simulate Acquisition 
a la inspección. 
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Verificando la Presencia del Agujero para la Igualación de 
Patrones 
Si el objeto bajo inspección está fijo y siempre aparece en la misma ubicación y orientación en 
las imágenes que va a procesar, la definición de una región de interés es muy sencillo. Sin 
embargo, si el objeto bajo inspección aparece rotado o movido dentro de la imagen, la región de 
interés necesitará rotarse o moverse junto con el objeto bajo inspección. 
Para poder mover la región de interés junto con el objeto, es necesario fijar un sistema de 
coordenadas relativo a alguna características original y significativa en el objeto bajo inspección. 
Seleccione una característica que siempre aparezca en el campo de visión de la cámara, 
independientemente de la ubicación de las partes entre imágenes. También asegúrese que la 
característica no se vea afectada por defectos grandes que puedan modificar su apariencia visual. 
El agujero central del filtro de aceite será nuestra característica única en la cual basaremos 
nuestro sistema coordenado. 
 
1. En la paleta de Inspection Steps, seleccione la lengüeta de Check for Presence. 

 

2. Presione el paso Match Pattern. Aparecerá una ventana de diálogo para el filtro de aceite. 

3. Dibuje la región de interés alrededor del área de la imagen que contenga el agujero central, 
como se muestra en la figura 6-1. Esta región se convierte en la plantilla de igualación de 
patrones. 
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Figura 6-1. Creando un Patrón en Plantilla 

 

4. Presione OK para aceptar la plantilla. 

Nota: Vision Builder for Automated Inspection ubica la plantilla en la región de interés en verde. 
La ubicación de la coincidencia se sobrepone a la imagen bajo inspección con un rectángulo rojo. 

5. En la lengüeta Main, escriba Locate Center en la caja de texto Step Name. 
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6. Redibuje o reduzca la región predeterminada de interés en verde para que únicamente rodee 
la porción del dispositivo que contiene la plantilla aprendida, como se muestra en la Figura 6-
2. 

 
Figura 6-2. Limitando la Región de Búsqueda 

Esta región de interés representa el área de la imagen en la cual Vision Builder for 
Automated Inspection buscará a la plantilla. 

7. En la lengüeta de Settings, fije Number of Matches to Find a 1. 

 

Nota: Note el control de Minimum Score. De manera predeterminada, todas las instancias de 
una plantilla deben de tener una calificación de coincidencia, o match store, de 800 o superior 
para ser considerado como válido. La calificación mínima puede variar entre 0 y 1,000. Una 
calificación de 1,000 significa una coincidencia perfecta.  

8. Escriba un valor de 750 en la caja de Minimum Score. 

9. En la lengüeta de Limits, seleccione la opción de Minimum Number of Matches. Fije el 
valor a 1. 



  

© National Instruments Corporation 42 NI Days 2006 Hands-On 

 

Note que la tabla de Matches contiene dos coincidencias: uno que cumple con los requisitos 
que usted fijó y otro con la siguiente mejor opción. Esta característica le ayuda a seleccionar 
una calificación mínima lo suficientemente alta para discriminar las partes correctas de las 
defectuosas, pero no tan alta que no pueda tolerar variaciones normales del proceso. 

10. Presione OK para agregar el paso a la inspección. 
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Pruebe la Inspección 
1. Presione el botón de Run Inspection Once localizado en la ventana de diagrama de 

inspección. 

 

Vision Builder for Automated Inspection carga la siguiente imagen, OilFilt1.jpg, del 
directorio Oilfilt y realiza el paso de Match Pattern en la imagen. Note que Step Status es 
PASS. 

Nota: El nombre de la imagen activa se despliega en la función Simulate Acquisition del 
diagrama de inspección.  

2. Pruebe las otras imágenes en el directorio de Oilfilt. Hay diez imágenes en total. 

Salve la Inspección 
1. Seleccione File»Save.  

2. Salve la inspección en la ubicación de C:\NI Days Hands On\VBAI\Exercises\ 
como Exercise 6.vbai.  
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Ejercicio 7: Verificación de Presencia de los Ocho Agujeros 
en el Filtro de Aceite 

Definición de un Sistema Coordenado 
Ahora que tenemos un punto de referencia en nuestra inspección, el agujero del filtro, podemos 
definir un sistema coordenado basado en la posición y orientación del agujero. 
1. Si no está abierto, seleccione File»Open y seleccione Exercise 2. 

2. Vaya al paso de Locate Center. Agregaremos los nuevos pasos después de éste. 

3. En la paleta de Inspection Steps, seleccione la lengüeta de Locate Features. 

 

4. Presione en el paso de Set Coordinate System. 

5. En la lengüeta de Main, escriba Coordinate System en la caja Step Name. 

6. En la lengüeta de Settings, seleccione Horizontal and Vertical Motion de la entrada Mode 
porque el filtro de aceite aparece corrido pero no rotado de una imagen a otra. 

7. Presione OK para agregar este paso a la inspección. 

Verificando la Presencia de los Ocho Agujeros 
Complete los siguientes pasos para configurar el paso de Detect Object que encuentre los 
agujeros en el filtro. 
1. En la paleta de Inspection Steps, seleccione la lengüeta de Locate Features. 

2. Presione el paso de Detect Objects. La página de propiedades del paso aparece. 

3. En la caja de Step Name, escriba Detect Small Holes. 

4. Use la herramienta annulus para dibujar una región de interés que contenga todos los 
agujeros pequeños, como se muestra en la Figura 7-1. (Tip: Haga su primer clic en el centro 
del círculo) 
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Figura 7-1. Definición de la Región de Interés 

5. En la lengüeta de Threshold, seleccione la opción de Dark Objects. 

 

Nota: La sombra azul resalta los pixeles oscuros--pixeles con valores de baja intensidad que caen 
dentro del rango del umbral--en la región de interés. Vision Builder for Automated Inspection 
agrupa los pixeles sombreados en objetos, que a su vez son enmarcados en los rectángulos rojos. 

6. Vaya a la lengüeta de Settings. 

7. Deshabilite la opción de Ignore Objects Touching the Region of Interest. 

8. Habilite Minimum Object Size y fije Minimum Object Size a 700 pixels2 (pixels2 es un 
parámetro fijo).  

Nota: Si el número de partículas es más de ocho después de fijar tamaño mínimo del objeto, 
necesitará habilitar la opción de Ignore Objects Touching Region of Interest, o ajustar el 
Threshold Range en la lengüeta de Threshold.  

9. En la lengüeta de Limits, seleccione las entradas Minimum Number of Objects y 
Maximum Number of Objects. Fije los valores a 8. 

10. Presione OK para agregar estos pasos a la inspección. 

11. Pruebe las otras imágenes en el fólder y asegúrese que detecte todos los agujeros. Debido a 
que OilFilt7.jpg es un tipo diferente de filtro de aceite, debe de fallar la inspección. 

12. Seleccione File»Save As y grabe la inspección como Exercise 7. 
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Ejercicio 8: Despliegue su Sistema de Visión 

Fijar el Estado de la Inspección 
1. En la paleta de Inspection Steps, seleccione la lengüeta de Use Additional Tools. 

2. Seleccione el paso Set Inspection Status para abrir su página de propiedades. 

La inspección se puede fijar a que Pase o Falle basada en diferentes criterios. En este caso, 
queremos que la inspección falle si alguno de los pasos anteriores falló.  
3. En la lengüeta de Main, escriba Set Inspection Status en la caja de Step Name.  

4. Asegúrese de seleccionar FAIL if any previous step fails en la sección de Inspection 
Status.  

5. Asegúrese de seleccionar Update Number of Parts Inspected. 

 
6. Presione OK para agregar este paso a la inspección.  

7. Salve el ejercicio como Exercise 8. 
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Despliegue de la Inspección 
11. Desde la Interfaz de Configuración, seleccione File»Switch to Inspection Interface para 

abrir la Interfaz de Inspección. Los pasos de la inspección del Ejercicio 8 aparecen en el 
panel de resultados. 

12. Presione el botón de Start Inspection. Vision Builder for Automated Inspection comienza a 
correr la inspección en la imágenes simuladas y actualiza las tres áreas de la Interfaz de 
Inspección con los datos de la inspección más reciente. 

 

De manera predeterminada, Vision Builder for Automated Inspection despliega todas las 
imágenes bajo inspección en la ventana de Display.  También puede cambiar las pantallas de 
despliegue en el menú de View para ver únicamente las imágenes que fallaron o para no 
desplegar nada.  También puede cambiar el tamaño de las imágenes desplegadas en el menú 
de Options. 
También, Vision Builder for Automated Inspection actualiza el panel de resultados (Results) 
mientras que la inspección corre.  Si no quiere actualizar el panel de resultados durante la 
inspección, deshabilite el control de Update Result Panel. 

13. Presione el botón de Stop Inspection para detener la inspección. 

14. Seleccione Inspection»Switch to Configuration Interface para regresar a la Interfaz de 
Configuración. 
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Ejercicio 9: Configurando un Sistema SCC DAQ en 
Measurement and Automation Explorer (MAX) 

En este ejercicio, configurarás una tarjeta DAQ y una acondicionador de señales SCC. Después 
de que la configuración esté completa, utilizarás los paneles de prueba en MAX para probar la 
funcionalidad del sistema DAQ. 
 

1. Da un clic en el ícono de MAX desde el menú de inicio rápido para abrirlo. En caso de 
que no haya ícono de acceso rápido, abre MAX desde el menú Start. 

  

Aparecerá una ventana como la de la ilustración. 

 

2. Con un clic sobre cada opción “+”, despliega los árboles de configuración Devices and 
Interfaces  y  NI-DAQmx Devices. 

3. Verifica que la tarjeta DAQCard-6062E esté listada. Si no, selecciona View»Refresh 
para actualizar la lista de dispositivos.
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4. Con un clic selecciona el dispositivo, y en la parte superior de la ventana de MAX da un 
clic en el botón Self-Test. 

 

Deberá de mostrarse un mensaje que diga The Device Has Passed the Test. Da clic 
en OK. 

 
5. Para configurar el acondicionador de señales SCC, da un clic derecho en NI-DAQmx 

Devices dentro del árbol de configuración y selecciona Create New NI-DAQmx 
Device»NI-DAQmx SCC Connector Block»SC-2345. 
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6. Nota que todas las ranuras, desde J1 hasta J21, en el SC-2345 están vacías. El 
acondicionador SCC cableado a tu tarjeta DAQ tiene cuatro módulos dentro: un módulo 
para permitir el paso de las señales análogas SCC-FT01, un módulo para termopar SCC-
TC02, un módulo para galga extensiométrica SCC-SG03, y otro para salidas análogas 
SCC-FT01. Para configurar el primer módulo SCC-FT01, da un clic en la flecha del 
menú desplegable junto a la ranura de J1 y selecciona SCC-FT01. 

 

7. Así mismo repite el paso 6 para los demás módulos: 

J2—SCC-SG03 

J3—SCC-TC02 

J17—SCC-FT01 

 Da un clic en el botón OK una vez que hayas terminado. Deberás ver ahora el 
acondicionador de señales SC-2345 listado bajo NI-DAQmx Devices en el árbol de 
configuración. 
 

8. Asegúrate que el cable BNC esté conectado a las dos entradas BNC al frente del 
acondicionador SCC. Esto conecta la entrada del módulo SCC-FT01 en el canal 0 de la 
tarjeta DAQ, a la salida del módulo SCC-FT01 canal 0 de la tarjeta DAQ. 
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9. Para sacar una señal analógica por el canal 0, da un clic derecho en la DAQCard-6062E 
debajo de NI-DAQmx Devices y selecciona Test Panels. Da un clic en la pestaña 
Analog Output, cambia la opción Output Mode a Sinewave Generation. Ingresa el 
valor 10,000 en Update Rate , y asegurate que la opción en Transfer Mechanism sea 
Interupts. Da un clic en el botón Stara para iniciar la salida analógica desde el canal 0. 

Nota: Los dispositivos PCMCIA DAQ solo utilizan interrupciones. Las tarjetas PCI y PXI DAQ 
poseen hasta seis canales DMA para transferencia de datos de alto desempeño. 

 

10. Da un clic en la pestaña Analog Input. Pon el Modo de Adquisición en Continuous, y 
coloca la Taza de Transferencia en 10,000. Da un clic en el botón Start. La onda seno 
que ves está siendo generada por la salida analógica del canal 0, y siendo leída de vuelta 
por la entrada analógica del canal 0 a través del cable BNC. 

11. Da clic en el botón Stop para finalizar la adquisición. Da un clic en la pestaña Analog 
Output. Da un clic en el botón Stop para detener la generación de la onda. Da un clic en 
Close para salir de los Paneles de Prueba. 
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12. MAX también contiene archivos de ayuda con información detallada para tu uso.  
Selecciona Help»Help Topics»NI-DAQmx»NI-DAQmx Help para ver la 
documentación referenciada de ayuda para NI-DAQ.   

 

 

13. Dispón de unos minutos para explorar los varios temas disponibles en la ayuda de NI-
DAQmx.  Los temas incluyen fundamentos de medición para los diferentes tipos de 
sensor y las aplicaciones más comunes, en adición de referencias específicas para utilizar 
el software.   

 

 

 

Fin del Ejercicio 9 
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Ejercicio 10: Medición de Temperatura en LabVIEW 

En este ejercicio configurarás y medirás un termopar en LabVIEW usando el asistente de 
LabVIEW 8.0 DAQ Assistant. Con el DAQ Assistant, no es necesario ningún tipo de 
programación para las tareas de adquisición de datos. 
 

1. Asegúrate que un termopar tipo J esté bien conectado a la entrada del termopar en el 
panel frontal del cargador SCC. Esto conecta el termopar al módulo de termopar SCC-
TC02 en el canal 2. 

2. Inicia LabVIEW desde la barra de tareas o desde el menú Start. 

  

3. Da un clic en New para iniciar un nuevo programa. En la siguiente ventana emergente, 
selecciona Blank VI y da un clic enOK. 

4. Teclea <Ctrl-E> para cambiarte al Diagrama de Bloques en LabVIEW. 

5. Muestra la Paleta de Funciones dando clic derecho en el espacio de trabajo del Diagrama 
de Bloques en LabVIEW. 

6. Selecciona el VI Express DAQ Assistant de la Paleta de Funciones ubicado en 
Express>> Input. Ahora da clic en el area en blanco del diagrama de bloques para 
colocar el DAQ Assistant VI. 
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 La siguiente ventana debe aparecer:  
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7. Para configurar el termopar da un clic en el botón Analog Input. En las siguientes 
ventanas, da un clic en el botón Temperature y después en el botón Thermocouple. Da 
clic en la cruceta “+” junto a SCC1Mod3 (SCC-TC02), selecciona el canal ai0, y da un 
clic en el botón Finish. 

 

8. En la siguiente ventana coloca el dato de 0 ºC a 100 ºC en Input Range. Coloca la 
opción CJC Source en Built-in y de clic en el botón OK. 
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9. Da un clic derecho en la terminal data del VI Express del  DAQ Assistant (la flecha de 
salida resaltada en azul al lado derecho) y selecciona Create»Graph Indicator. 

 

10. Teclea <Ctrl-E> para cambiarte al Panel Frontal del VI. Nota la gráfica existente. Ésta 
fue creada a partir del Diagrama de Bloques cuando seleccionaste crear un indicador 
gráfico. 
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11. Haz clic en la flecha blanca Run localizada en la esquina superior izquierda del Panel 
Frontal para correr el VI. Verifica la lectura del termopar en la gráfica. 

 
Nota: La aplicación que configuraste en LabVIEW está configurada para obtener una lectura de 
100 puntos en 0.1 segundos. 
 

12. Para correr continuamente el VI, da clic en el botón Run Continuously. 

 

13. Toca el termopar para incrementar la temperatura. 

14. Da nuevamente clic en el botón Run Continuously para detener el VI. 

15. Ve al menú File y selecciona Save As. 

16. Guarda el VI como Thermocouple Input.vi en la carpeta C:\NI Days Hands 
On\DAQ\Exercises\. 

17. Cierra el VI. 

Fin del Ejercicio 10 



  

© National Instruments Corporation 58 NI Days 2006 Hands-On 

Ejercicio 11: Generación de una Forma de Onda de una Salida 
Análoga 

En este ejercicio, utilizarás el DAQ Assistant para construir en LabVIEW un VI que genere la 
forma de onda de una salida analógica. Luego construirás un segundo VI para medir la forma de 
onda usando un canal de entrada analógica. 
 

1. Si cerraste LabVIEW al final del último ejercicio, inícialo y abre un nuevo VI. 

2. Teclea <Ctrl-E> para presentar el Diagrama de Bloques de LabVIEW. 

3. Examina la subpaleta Input de la paleta Functions, selecciona con un clic el VI Express 
Simulate Sig. Coloca el VI en el Diagrama de Bloques. 

 

4. En la sección Timing de esta ventana, coloca la lectura de las muestras por segundo (Hz) 
a 10,000 y da clic en OK. 
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5. Posiciónate nuevamente en la paleta Functions y selecciona el VI DAQmx Assistant en 
la  subpaleta Output. Coloca el VI en el Diagrama de Bloques. 

6. En la ventana Create New, selecciona Analog Output como el Tipo de Medición. En la 
siguiente ventana, selecciona Voltage. Ya en la siguiente ventana, en la opción de cruceta 
“+” junto a SCC1Mod17 (SCC-FT01), selecciona la opción ao0, y da clic en Finish. 

7. En la ventana de configuración del DAQ Assistant, selecciona Generate Continuously 
de la pestaña Task Timing, localizada en la parte media baja de la ventana. Desmarca la 
opción Use timing from waveform data, y establece la taza de transferencia (Hz) en 
10,000. Da clic en el botón OK. 
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8. En el Diagrama de Bloques, mueve de posición el VI Express DAQ Assistant a la 
derecha del VI Express Simulate Signal. Cablea la salida Sine del VI Simulate Signal a la 
entrada data del VI DAQ Assistant. Para cablear, mueve el cursor del mouse a la flecha 
azul de la terminal de salida Sine del VI Simulate Signal, y con un clic izquierdo 
comienza el cableado. Mueve ahora el cursor a la terminal de entrada data del VI DAQ 
Assistant, y con otro clic izquierdo fija el cableado. 
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Tu Diagrama de Bloques debe verse como el siguiente. 

 

9. Para hacer que el VI corra continuamente, crearás un Ciclo While. Un Ciclo While 
provoca que todas las partes de un programa dentro del ciclo se ejecuten continuamente 
hasta que se presione el botón Stop. Para crear el Ciclo While, navegue a la subpaleta de 
Exec Ctrl desde la paleta de Functions y seleccione el ciclo While. 
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10. Dibuja el Ciclo While alrededor del Diagrama de Bloques. Tu Diagrama de Bloques debe 
verse como lo siguiente. 

 

11. Crea un control numérico de perilla para controlar la frecuencia de la onda seno. Para 
crear una perilla primero presenta el Panel Frontal de LabVIEW (teclea <Ctrl-E>). Si no 
es visible la Paleta de Controles, da un clic derecho en el área de trabajo y se mostrará. 
Selecciona Knob de la subpaleta Numeric Controls dentro del la paleta Controls. 
Coloca la perilla en el Panel Frontal. 

 



  

© National Instruments Corporation 63 NI Days 2006 Hands-On 

12. Da un clic derecho en la perilla y selecciona Properties. En la pestaña Appearance 
cambia la etiqueta a Frequency. En la pestaña Scale cambia la Scale Range, que 
Minimum sea 0.00 y Maximum sea 1000.00. Da clic en OK para cerrar la ventana de 
Propiedades.S 

13. Teclea <Ctrl-E> para posicionarte en el Diagrama de Bloques. Nota como la perilla de 
Frecuencia, su terminal es de color naranja. Mueve el control dentro del Ciclo While a la 
izquierda del VI Express Simulate Signal. Cablea la perilla de su terminal a la entrada 
Frequency del VI Express Simulate Signal (la segunda flecha naranja en la izquierda del 
VI). 

Nota: Asegúrate que la perilla quede cableada a la terminal correcta a la entrada del VI Express 
Simulate Signal. Si realizaste mal la conexión, da doble clic sobre el cable y teclea <Delete>. 
 
Tu diagrama de bloques debe verse como el siguiente: 

 

Con esto, el VI usará la perilla de frecuencia en el Panel Frontal de LabVIEW para generar la 
onda seno a una frecuencia específica. Esta onda seno en generada por la salida analógica del 
canal 0 del VI Express DAQ Assistant. La salida analógica del canal 0 está conectada al 
conector bajo BNC del SCC. 

14. Guarda el VI como Analog output.vi en la carpeta C:\NI Days Hands 
On\DAQ\Exercises\.  

15. Abre un VI nuevo de LabVIEW para crear una entrada analógica al programa DAQ. Para 
abrir un nuevo VI, ve al menú File y selecciona New VI. 

16. Presenta el Diagrama de Bloques y coloca el VI Express DAQ Assistant, desde la 
subpaleta Input en la paleta Functions. Selecciona Analog Input como el Tipo De 
Medición. En la siguiente ventana selecciona Voltage. A la siguiente ventana, en el menú 
desplegable “+” junto a SCC1Mod1 (SCC-FT01), selecciona ai0, y da clic en Finish. 
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17. En la ventana del DAQ Assistant selecciona de la pestaña Task Timing, Acquire 
Continuously. Establece Rate (Hz) a 10,000 y da clic en OK. 

18. Dibuja un ciclo While alrededor del VI Express DAQ Assistant (el ciclo While está en la 
subpaleta Exec Ctrl en la paleta Functions). 

19. Crea un indicador gráfico para desplegar los datos de la entrada análoga. Para crear este 
indicador gráfico, da clic derecho en la terminal data del VI Express DAQ Assistant y 
selecciona Create Graph Indicator. 

 

20. Guarda el VI como Analog input.vi en la carpeta C:\NI Days Hands 
On\DAQ\Exercises\.  

21. Corre el VI. 

22. Si cerraste el VI de salida analógica que creaste anteriormente, ábrelo y córrelo. Utiliza la 
perilla Frecuency del Panel Frontal para controlar la frecuencia de la onda seno y observa 
la gráfica en el Panel Frontal del VI de entrada analógica para monitorear esa onda. 

Con el VI de salida analógica estás generando una onda senoidal transmitida por el canal 0, 
el cual está conectado al conector BNC bajo del SCC. El VI de entrada analógica está 
monitoreando la entrada analógica del canal 0, que está conectada al conector alto BNC del 
SCC. La salida analógica y la entrad, están conectadas a través del cable BNC. 

23. Detén los VIs y cierra todas las ventanas.  

Fin del Ejercicio 11 
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Ejercicio 12: Control de Luces e Interruptores 

En este ejercicio utilizarás el DAQ Assistant y la generación automática de código para controlar 
las 8 líneas digitales de E/S para ya sea enviar o recibir 5V en una señal TTL. 
 

1. Inicia LabVIEW. 

 

2. Abre un nuevo VI. 

3. Teclea <Ctrl-E> para cambiarte al Diagrama de Bloques. Si no es visible, con un clic 
derecho sobre el área de trabajo muestras la paleta Functions. Coloca un DAQmx Task 
Name Constant en el Diagrama de Bloques desde la subpaleta All Functions » NI 
Measurements » DAQmx. 

4. Da un clic derecho en DAQmx Task Name Constant y selecciona New Task (DAQ 
Assistant).  La ventana del DAQ Assistant debe aparecer. 

5. Selecciona como Tipo de Medición Digital I/O, y en la siguiente ventana selecciona Port 
Output. A la ventana siguiente da clic en la cruceta “+” junto a Dev1 y selecciona port0, 
da clic en Finish. 

6. Ingresa un nombre para tu tarea. Ya en la siguiente ventana nota que tienes la posibilidad 
de cambiar la lógica digital de la línea. Deja esa casilla en blanco y da clic en OK. 

7. Utiliza esta tarea que apenas creaste para para generar código modificable en LabVIEW 
haciendo clic derecho en DAQmx Task Name Constant y seleccionando Generate 
Code » Example. Los VIs de NI-DAQmx requeridos para realizar esta tarea deben de 
aparecer en tu diagrama de bloques. 

8. Necesitarás modificar ligeramente este código para trabajar con la aplicación. Borra el 
control data conectado al VI, y usa el selector polimórfico en el VI DAQmx Write 
seleccionando Digital » Single Channel » Multiple Samples » 1D U32 (port format). 
Esto te permitirá escribir los datos digitales a todas las líneas del puerto. 

9. Ahora necesitarás un nuevo control para crear los datos que el VI DAQmx Write sacará 
por las líneas digitales. Da un clic derecho en la terminal de entrada data del VI DAQmx 
Write y selecciona Create » Control.  

10. Da un clic derecho en el control de datos que recién creaste y selecciona Properties. En 
la pestaña Appearance cambia la etiqueta a light control. Da clic en OK para 
cerrar la ventana de propiedades. 

11. Dibuja un ciclo While que alrededor de tu código (el ciclo While se encuentra en la 
subpaleta Exec ctrl de la paleta Functions). Tu diagrama de bloques debe verse como el 
siguiente. 
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12. Teclea <Ctrl-E> para cambiarte al Panel Frontal de LabVIEW y corre el VI. 

13. Presiona las flechas arriba/abajo del área gris del control, para modificar el valor de la 
muestra digital. Observa cómo los LEDs al frente del SCC cambian de acuerdo con esa 
muestra. Los LEDs están conectados al puerto digital que estás controlando. 

 

14. Nota: El control de luces es un arreglo de controles numéricos. El número externo (de la 
casilla blanca) y las flechas arriba/abajo controlan el índice del arreglo. Como solo se está 
utilizando un puerto digital, solo tenemos un elemento en el arreglo (el elemento 0). El 
control numérico interno (de la casilla gris) cambia el valor del elemento 0 en el arreglo 
del control de luces. 

15. Cambia el valor del control de luces a 0 para poner los LEDs en su estado inicial y da clic 
en el botón Stop para detener el VI. 

16. Guarda el VI como Digital IO.vi en la carpeta C:\NI Days Hands 
On\DAQ\Exercises\. Cierra todas las ventanas. 

Fin del Ejercicio 12 
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Ejercicio 13: Cuenta de Crestas con un Contador/Temporizador 

En esta lección construirás un programa utilizando el API de NI-DAQmx (interfaz de aplicación 
para programación - application programming interface), que cuenta el número de veces que una 
línea digital es utilizada. Utilizarás uno de los dos contadores/temporizadores incluidos en la 
tarjeta, conectado a una línea digital dentro del SCC. 
 

1. Inicia LabVIEW y abre un nuevo VI. 

2. Teclea <Ctrl-E> para posicionarte en el Diagrama de Bloques. Si no es visible, da un clic 
derecho en el área de trabajo para mostrar la paleta Functions, y coloca el VI DAQmx 
Create Virtual Channel desde la paleta All Functions » NI Measurements » DAQmx 

– Data Acquisition, en el diagrama de bloques. Usa el selector polimórfico para 
configurarlo como una operación Counter Input » Count Edges. 

3. También toma desde la misma paleta los VIs DAQmx Start, DAQmx Read, y DAQmx 
Stop, y colócalos en tu Diagrama de Bloques. Usa el selector polimórfico en el VI 
DAQmx Read para configurarlos a que regresen datos de respuesta en el formato 
Counter » Single Sample » U32. Conecta las entradas y salidas de error, y las entradas y 
salidas de la tarea, a manera que tu Diagrama de Bloques se vea como el siguiente: 

 

4. Da un clic derecho en la entrada counter del VI DAQmx Create Virtual Channel y 
selecciona Create » Constant. Haz clic en la constante que aparece y selecciona el 
contador que utilizarás para esta operación: Dev1/ctr0. 

5. Haz clic derecho en la salida data del VI DAQmx Read y selecciona Create » 
Indicator. Esto registrará y mostrará la cuenta en el contador. 

6. Coloca un ciclo While alrededor del VI DAQmx Read y el indicador data, desde la 
paleta Functions»Execution Control. Haz creado un programa que monitoreará la salida 
del Contador 0 y que continuamente contará el número de pulsos en éste, hasta que 
presiones el botón Stop. Tu diagrama de bloques debe verse como el siguiente: 
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7. Para generar los pulsos, acciona varias veces el interruptor al frente del módulo de 
acondicionamiento de señales SCC. 

8. Nota: Cada vez que accionas el interruptor el contador registrará varios pulsos. Esto se 
debe al fenómeno de “boteo” o rebote, que es común en los interruptores o actuadores 
con sistemas mecánicos. Antes de pasar directamente al estado abierto o cerrado, estos 
sistemas generan un “brinco” al estabilizarse, similar al efecto de una pelota cuando es 
lanzada. Los dispositivos de hardware que estamos utilizando no tienen filtro contra el 
rebote dentro de los contadores. Pero otros los dispositivos de la Serie M, en formato PCI 
y PXI, tienen integrados filtros anti-rebotes. 

Fin del Ejercicio 13 

 
 


